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Help and Support

Welcome

The Harris HF Tactical Chat application provides an easy to use interface for transferring simple
text messages and files using Harris HF radios: RF-7800H-MP, RF-5800H-MP, and AN/PRC-
150(C). The application has limited knowledge of the radio and assumes that the radio is
already setup. As peer-to-peer messenger application, it is capable of sending and receiving
messages from one or more stations. However, only one message is managed and transferred
at a time.

The Network Radio Driver Installer (NRDI) is required to create a Point-To-Point (PPP)
connection to HF radios using a Harris modem.

This HF Tactical Chat help provides guidance on the following topics:

o Startup

o Installation and Setup

e Operation
e Troubleshooting (FAQ Index)

For an overview of new features, refer to What's New.

All acronyms used in the Help system are defined in the Glossary.
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Applicable Documents

The following documents contain useful information on radio operation and interoperability.
Harris recommends consulting the radio’s operation manual for detailed descriptions of
waveform functions.

e RF-7800H-MP HF Manpack Radio Operation Manual (10515-0413-4200)
e RF-5800H-MP Advanced Tactical HF Radio Operation Manual (10515-0117-4200)
e AN/PRC-150(C) Advanced Tactical HF Radio Operation Manual (10515-0103-4100)
e Help for the following software:

e CPA for RF-7800H

o CPA for RF-5800H

e CPA for AN/PRC-150



Help
Startup

Startup Overview

The following topics are included in Startup:

e Quick Start

o Application Overview

Help and Support
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Quick Start

This section provides a quick-start guide to Tactical Chat.

The Tactical Chat application transfers text messages and files using RF-7800H-MP, RF-
5800H-MP, and AN/PRC-150(C), radios.

Verify that system requirements are met, and the radio is appropriately programmed with
system and modem presets before installing and using Tactical Chat. For additional information,
click these links: Application Overview, System Requirements, Radio Setup.

The following activities provide a summary on how to use Tactical Chat.
Installation and Setup

Also refer to Setup.
1. Install the Tactical Chat application by following the Installation defaults.

2. If prompted, perform a Modem Installation or Dial-Up Networking Installation.

Startup and Station Information Entry

For additional information, refer to: Operational Overview.

1. Start the Tactical Chat application by clicking on the Tactical Chat icon l: a on the PC
desktop. This will open the Tactical Chat User Interface, displaying either the Classic
View or the Green View.

2. Select a Tactical Chat Auto Save location and file name (*.chx).
3. Select the Connections type. A restart of the application is required after this selection.

4. For the Ethernet connection, enter the Ethernet IP Address in the Ethernet Address field
using the format ##.#.#.#. The default Ethernet IP Address is 169.254.78.1.

5. Type the Radio Address of the local radio in the Set Self Address field, then click in the
Composition Pane to automatically update the My Station field with the Self Address
data.

6. Inthe Talking To: field, type in the radio address of the remote station.
7. Set any desired Tactical Chat Options, such as Auto Save or Show Time.

Creating a Message

To create a message, type message text into the Composition Pane.
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Sending a Text Message
To send a message, click the Send button.
Sending a File

1. Click the Send File button.
2. Use the Browse feature to navigate to the file you want to send.

3. Highlight the desired file, and click Open.
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Application Overview

The HF Tactical Chat application transfers text messages and files using RF-7800H-MP, RF-
5800H-MP, and AN/PRC-150(C) radios.

The application assumes that the radio has been pre-programmed with system and modem
presets. HF Tactical Chat operates best with the ARQ and 3G modem waveforms. It also
supports Serial and MIL-110B modem waveforms. For additional information, click these links:
System Requirements and Radio Setup.

The application can send and receive messages from one or more stations. Only one message
can be managed and transferred at a time. Broadcast messages can be sent from one station to
multiple stations in the same subnet. Refer to Operational Overview for more information.

The application is designed for a PC platform. The application is available in the English
language only, but will run on localized versions of operating systems using other languages.
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Installation and Setup
Installation and Setup Overview

For a general overview of Tactical Chat application, refer to the Application Overview.

The following topics are included in Installation and Setup:
Installation:

e System Requirements

o [nstallation
e Uninstall
Setup:

Depending on hardware configuration, some additional setup steps may be necessary after the
Tactical Chat application is installed.

Harris RFC Radio Connection Modem installation or Dial-Up Networking installation may or may
not be required, depending on the selected hardware configuration. If either of these options is
required, prompts will be seen the first time that the Tactical Chat application is started up.

e Radio Setup

e Modem Installation

o Dial-Up Networking

o Station Setup



10515-0294-5002

Installation
System Requirements

This section provides information on Tactical Chat System Requirements and Harris Software
Compatibility.

Tactical Chat System Requirements

Component Recommended

Windows XP

Windows Vista 32/64-bit

Windows 7 32/64-bit

Windows Server 2003 Server 32/64-bit
Windows Server 2008 Server 32/64-bit
Windows Server 2008 R2 64-bit

Operating System

PC As required to support operating system.
Serial Port One required for radio connection.
Disk Drive CD-ROM drive

Super VGA color monitor with resolution of 800 pixels

horizontal by 600 pixels vertical and minimum
Display 256 colors is recommended. Minimum requirement

is a resolution of 640 pixels horizontal

by 480 pixels vertical with 16 colors.

Harris Software Compatibility:

Tactical Chat may be used on a PC with other Harris software. However, multiple applications
should not be used to connect to radios simultaneously.
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Installation

Before beginning Tactical Chat installation, ensure that minimum System Requirements are
met. It is assumed that the operating system software has been previously installed.

CAUTION

Do not attempt to run Tactical Chat and other Harris software
radio connections simultaneously. Multiple applications cannot
function properly when they are connecting to a radio at the same
time. If multiple applications are connecting at the same time, it
will be necessary to close the applications and then restart the
single desired application.

Before beginning the Tactical Chat software installation process, it is recommended that all
running applications be shut down to avoid loss of data.

To install the Tactical Chat application:

1.
2.

Insert the Tactical Chat software installation CD into the CD-ROM drive.

If AutoPlay for CDs is implemented on your computer, the setup process will begin
automatically. If AutoPlay is not implemented on your computer, open the CD ROM drive
and select HarrisAutoStart to start the installation.

Select Software in the heading and then select Install HF Tactical Chat v2.0.
The Harris Tactical Chat Welcome screen will appear. Select Next>.

Accept the license agreement and follow the on-screen instructions to do a Complete
install of the Tactical Chat application. Select Finish when the installation is done.

When Tactical Chat installation is complete, the Tactical Chat icon will be visible on the
PC desktop. To start Tactical Chat, click on the Tactical Chat icon. When Tactical Chat
is active, a Tactical Chat icon will be visible in the system tray. The Start path is: Start >
All Programs > Harris RF Communications > Tactical Chat > Tactical Chat.

If modem installation or Dial-Up Networking installation is required, the prompt shown
below will appear. For additional setup steps which may be required for Modem
installation or Dial-Up Networking installation, click here: Setup.

This is your first time running the Tactical Chat, please take a moment
__ l % toinstall the Harris Modermn and Dial-up Connection,
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If Tactical Chat installation was unsuccessful, the Tactical Chat software should be uninstalled
and reinstalled. For Tactical Chat uninstall instructions, click here: Uninstall.

10
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Uninstall

To uninstall the Tactical Chat application:
1. Use Control Panel > Programs and Features to uninstall Harris Tactical Chat.

2. Accept defaults and follow the on-screen instructions to uninstall the Tactical Chat
application.

11
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Radio Setup
Radio Setup Overview

The radio must be properly set up for Tactical Chat to function. Mission parameters are
programmed into the radio using the Communication Planning Application (CPA) for RF-7800H-
MP, CPA for RF-5800H-MP, or CPA for AN/PRC-150. The HF-RPA can also be used for
programming RF-5800H-MP or AN/PRC-150 radios. The following topics are covered in this
section.

o Compatible Radio Models

e Supported Modes of Operation

e Connecting Computer and HF Radio

12
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Compatible Radio Models:

Tactical Chat functions with Harris RF-7800H-MP, RF-5800H-MP, or AN/PRC-150(C) radios
only. Radio setup is similar for all of these radio models. These radios have an embedded
modem that provides data rates up to:

e 2400 bps when using a serial tone Military Standard (MIL-STD)-110A modem waveform
e 9600 bps when using a serial tone MIL-STD-110B modem waveform

e 9600 bps when using the STANAG 4538 waveform
Supported Modes of Operation:

Supported HF radios offer four main modes of operation: Automatic Link Establishment (ALE),
Fixed-Frequency Mode (FIX), Frequency Hopping, and 3G. For robust, error-free data transfer,
the HF radios incorporate an ARQ capability based on the FED-STD-1052 data protocol or 3rd
generation (STANAG 4538) data protocol.

The mode of operation and appropriate presets must be selected by the user from the front
panel of the radio. Refer to the Applicable Documents for help on changing operating modes
and presets.

Tactical Chat does not provide built-in automatic linking functionality except in 3G mode. In
ALE mode, links must be established from the front panel of the radio prior to sending a
message.

Supported Modes of Operation

Waveform or ALE FIX HOP 3G Maximum
Protocol Data Rate
ARQ YES YES YES NO 2400 bps
Serial *** YES YES YES NO 2400 bps
MIL-110B *** YES YES NO NO 9600 bps
3G NO NO NO YES 4800 bps

*** The radio must be configured to route modem data to RDP in order to use the MIL-110B or
Serial waveforms. There is no automatic error correction on the data. Please refer to Applicable
Documents for details.

NOTE: The radio has a special PROG mode for configuring the
parameters of the radio. If an attempt is made to send a Tactical
Chat message while the radio is in PROG mode, the Tactical Chat
application will generate an error message.

13
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Connecting Computer and HF Radio
Ethernet and PPP connections are supported as describe below.
Ethernet Connection for RF-7800H-MP

For RF-7800H-MP, a direct USB Ethernet connection can be made using the Direct USB cable,
12043-2850-A006. By default, the radio is configured for a DIRECT USB Ethernet interface
([IPGM] > CONFIG > NETWORK, INTERFACE > ETHERNET > ADDRESS) and the Dynamic
Host Configuration Protocol (DHCP) SERVER is ENABLED. Record the radio IP ADDRESS for
entry into Tactical Chat.

After making a direct USB connection, a drive letter will appear for the USB port (for example:
A01368_RED (E:)). Copy the ushdrivers folder onto your desktop and use this location to install
the Harris Remote Network Driver Interface Specification (RNDIS) Network Device driver and
other serial drivers. For Windows XP, you can disconnect and reconnect the cable to get the
prompts to load the drivers. For Windows 7, select Device Manager > Other Devices and use
the context menu to Update Driver Software....

PPP Connections

Make PPP connections between the Tactical Chat System and the RF-7800H-MP, RF-5800H-
MP, or AN/PRC-150(C) with the cable, Harris part number 10535-0775 or 10518-1694. The
Network Radio Driver Installer (NRDI) application provides the drivers for these connections.
Pinouts for these cables are shown below. The connection is between a COM port on the
Tactical Chat System PC and the Data (J3) connector on the HF radio.

A RFI filter (10518-2353-02) may need to be connected to COM port 1 as part of another
installation (for example, WMT). Cable connections to any of the computer ports should be
made through these filters where required.

MESSAGING
COMPUTER HF MP RADIO

—I 1053560775 r

COM PORT 1 J DATA

10518-1694 L J3

Interconnection to a Harris HF Manpack Radio

14



Cable 10535-0775 Pin Outs

Help and Support

Computer - COM Port 1 Data J3 (RF-5800H-MP, RF-7800H- Function
MP)
1 9 DCD
2 21 RXD
3 8 TXD
4 22 DTR
5 5 Ground
Cable 10518-1694 Pin Outs
Computer - COM Port 1 Data J3 (RF-5800H-MP, RF-7800H- Function
MP)
1 9 DCD
2 21 RXD
3 8 TXD
4 22 DTR
5 5,13 Ground

NOTE: To make the physical connection from the radio to a
computer that does not have a serial port, a commercially-
available Serial-to-USB adapter must be used to make the
connection. This adapter must have driver software in order for
NRDI to successfully identify the USB/COM port during setup.

15
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Modem Installation
Installing a Harris RFC Radio Connection Modem for Windows

1. If no modems were installed previously, the Phone and Modem Options dialog box will
open. Click on Add... to continue.

2. If another modem had been installed previously, you will get the Phone and Modem
Property page as shown below.

3. If the Harris RFC Radio Connection V2.4 is already installed click OK to continue the
installation, and click exit below to close the modem installation instructions.

4. On the Modems tab, click Add... to continue.

" Phone and Moderr
Digling Rules | Modems | Advanced

_’r-; The following modems are installed:

Modem Attached To
| Haris RFC Radio Connection V2.4 COM1

[ 'ﬁ'ﬂdd... ] ['@.'Hemwe ] [ Properties

| ok || cancel |

Phone and Modem Property Page

16
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Modem Detection

1. On the Add/Remove Hardware Wizard, check Don't detect my modem; | will select it
from a list.

2. Click Next to continue.

Install New Modem
Do you want Windows to detect your modem?

Windows will now try to detect your modem. Before
continuing, you should:

1. K the modem is attached to your
computer, make sure i is tumed on.

2. Quit any programs that may be using
the modem.

Click Mext when you are ready to continue.

v Dont detect my modem; | will select # from a list.

Install New Modem

17
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Modem Manufacturer List

1. The next dialog box lists modem manufacturers and models. Search for Harris from the
Manufacturers List.

2. If Harris Modem is in the list. Select Harris Modem from the Manufacturers list and then
select Harris RFC Radio Connection V2.4 from the Models list. Click Next to continue.

3. If Harris Modem is not in the list. Click Have Disk... to continue.

Select the manufacturer and model of your modem. If your modermn is not listed, or if you have
an installation disk, click Have Disk.

Manufacturer Models
(Standard Modem Types) [ZHarris RFC Radio Connection V2.4

;] This driver has an Authenticode(tm) signature. Hawve Disk...

Tell me why driver signing is important

Install New Modem

18
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COM Port Selection

1. From the Install New Modem dialog box, highlight the COM port to which the radio will
be connected.

2. Click Next to continue.

Install New Modem
Select the port(s) you want to install the modem on.

You have selected the following modem:
Hamis RFC Radio Connection V2 .4

On which ports do you want to install it ?

i Al ports
¥ Selected ports

COomM3
com4

Install New Modem

19
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Adding a Harris RFC Radio Connection Modem from Disk

1. In the next dialog box, Install From Disk, click Browse and, in the Open dialog box,
navigate to the CD-ROM drive.

2. In the root directory of the CD-ROM, highlight the file mdmrfc.inf, (if this file is not
selectable type it in the filename box).

3. Click Open.

4. Click OK to continue with the Install New Modem dialog box.

fin=til From Dkl -l

Insert the manufacturer’s installation disk, and then

make sure that the comect drive is selected below.

Copy manufacturer’s files from:

Install From Disk Dialog Box

20
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Selecting the Harris RFC Radio Connection Modem

1. Highlight Harris RFC Radio Connection V2.4 in the Install New Modem dialog box.

2. Click Next to continue.

i Select the manufacturer and model of your modem. If your meodem is not listed, or if you have
a,# an installation disk, click Have Disk.

Manufacturer Models
(Standard Modem Types) [5;]Harris RFC Radic Connection V2.4

[5;] This driver has an Authenticode(tm) signature. Have Disk...

Tell me why driver signing is important

Install New Modem

21
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Finishing Modem Installation

1. On the next page, click Finish to return to the Modems Properties dialog box, and then
click OK to continue the installation.

2. Click exit below to close the modem installation instructions.

Install New Modem
Maodem installation is finished!

“four modem has been set up successfulby.

if you wart to change these settings, double-click the
Phone and Madem Options icon in Control Panel, click the
Madems tab, select this modem, and then click Properties.

Install New Modem

22
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Dial-Up Networking
Network and Dial-up Connections for Windows

The dial-up connection uses a serial port to make a PPP connection. The NRDI application
automatically creates this entry to support this connection.

1. From the Windows XP Start menu, select Settings, then Network and Dial-up
Connections, and then click on Make a New Connection.

From the Windows 7 Start menu, select Control Panel, then Network and Sharing
Center, and then select Set up a new connection or network. You will get the dialog
box as shown in part below.

2. Click Next to continue.

Change your netwerking settings

ﬁ. Set up a new connection or network

-
Set up a wireless, broadband, dial-up, ad hoc, or VPN connection; or set up a router
or access point.

y ™ Connect to a network

—

Connect or reconnect to a wireless, wired, dial-up, or VPN network connection.

" a Choose homegroup and sharing options

Access files and printers located on other network computers, or change sharing
settings.

[=s Troubleshoot problems

Diagnose and repair network problems, or get troubleshooting information,

e e L e e B e L L L e L e L Lo et L Lt e e L e ]

Network Connection Wizard

23
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Network Connection Type

1. Select Dial-up to private network (Windows XP) or Set up a Dial-up Connection

(Windows 7).

2. Click Next to continue.

I'\_J'l @ Set Up a Connection or Network

Choose a connection option

Connect to the Internet
Set up a wireless, broadband, or dial-up connection to the Internet.

| Set up a new network
wgg-, Configure a new router or access point.

Connect to a workplace
. Set up a dial-up or VPN connection to your workplace.

Set up a dial-up connection

Connect to the Internet using a dial-up connection

] [ Cancel

Network Connection Type

24
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Phone Number to Dial

1. Supply a Dummy value ("123") in the Phone Number: field.

2. Select Allow other people to use this connection. This selection, which includes
internet sharing, is made on additional dialogs in Windows XP.

3. Type the Connection name you want for your connection. This selection is also made
later on in Windows XP.

4. Click Connect to create the connection.

= | |

-
Q || Create a Diial-up Connection

Type the information from your Internet service provider (ISP)

Dial-up phone number 123 Dialing Rules
User name: [Mame your ISP gave you]
Password: [Password your ISP gave you)

[] Show characters

[] Remember this password

Connection name; Dial-up Connection

'&' [¥] Allow other people to use this connection

This option allows anyone with access to this computer to use this connection,

I don't hawve an I5P

[ Connect ][ Cancel

Network Connection Type

25
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Connect Dial-up Connection

1. Click on Properties to continue.

I Iser name:

Fassword:

[] Save this user name and password for the following users:

Me onhy
l@' Anyone who uses this computer

Dial: 123 -

e [ e =

Connect Dial-up Connection

26



Dial-up Connection

Help and Support

1. The Harris Radio Connection Dialog will be displayed. Click on Configure to get the
Modem Connection dialog box.

General |Optinns | Security | MNetworking | Sharing|

Connect using:

|@ Madem - Hamiz RFC Radio Connection V2.4 ({COM1)

Phane number

Area code: Phone number:

123 Altemates
Country/region code:;
[] Use dialing rules Dialing Rules

See our online pivacy statement for data collection and use
infarmation.

] [ Cancel

Harris Radio Connection-General

2. Make sure all Hardware Features selections are unchecked (as shown below).

3. Click OK to continue.

27
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28

Maximum speed (bps): | 115200

Madem protocol

Hardware features
[] Enable hardware flow control
[] Enable modem emor control

[] Enable modem compression

[] Enable modem speaker

J |

Modem Configuration



Harris Radio Connection Properties

Help and Support

1. Click on the Options tab, and make sure the options are as shown below.

Genemll Options |Sec:urit}r | Metwarking | Sharing|

Dialing options
Display progress while connecting
Prompt for name and password, cerificate, etc.

[ Include Windows logon domain
Prompt for phone number

Redialing options

Redial attempts: 3

Time between redial attempts: [1 minute

|dle time before hanging up: [Eﬂ minutes

|dle threshold:
[] Redial f ling is dropped

PPP Settings. ..

Harris Radio Connection-Options

2. Now click on the PPP Settings button to get the PPP Settings dialog, and make sure all

the PPP Settings are unchecked.

3. Click OK to close the dialog.

[] Enable LCP extensions
[ Enable software compression

[] Megotiate multiHink for singledink connections

| ok || Cancel

PPP Settings

29
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4. Click on the Security tab and make sure it is set up as shown below.

5. Click here to continue with the Networking tab.

| General | Options | Security | Metwarking | Sharing|
Data encryption:

[Dptinnal encryption {connect even if no encryption)

Authertication
() Use Extensible Authertication Protocal (EAP)

Properties
i@ Allow these protocols

Unencrypted password (PAP)
Challenge Handshake Authentication Protocal (CHAP)
Microsoft CHAP Version 2 (M5-CHAP v2)

[] Automatically use my Windows logon name and
password (and domain, if any)

Interactive logon and scripting
[] Show terminal window

[] Run script:

Harris Radio Connection-Security
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Harris Radio Connection Properties - Continued

1.

and "Client for Microsoft Networks".

| General | Options | Security | Metworking |Sharir|g |

This connection uses the following tems:

& Intemet Protocol Version & (TCP/IPvE)
& Intemet Protocol Version 4 (TCP/1Pv4)
I:l g File and Prirter Sharing for Microsoft Metwors

it Client for Microsoft Networks

[ @.‘ Install... ] [ @.‘ Uninstall Properties

Description

Allows your computer to access resounces on a Microsoft
network.

Harris Radio Connection-Networking

2. Highlight the component "Internet Protocol Version 4 (TCP/IPv4)", and Click on
Properties, to get the TCP/IP dialog shown below.

Click on the Networking tab, and select both components "Internet Protocol(TCP/IP)",

31



10515-0294-5002

32

You can get |P settings assigned automatically if your network
supports this capability. Ctherwise, vou need to ask your netwaork
administrator for the appropriate |P settings.

(7 Obtain an |P address automatically

i@ Use the following IP address:

IP address: 0.0 .0 . 2

Obtain DMNS server address automatically

i@ Use the following DNS server addresses:
Prefemed DNS server: .

Altermate DMNS server:

| ok || cancsl

Internet Protocol (TCP/IP) Properties

3. Make sure the IP Address is "10 0 0 2", and also make sure the selection "Use the
following DNS server addresses:" is checked.

4. Click on the "Advanced..." tab to get the Advanced TCP/IP Settings window below.
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IF Settings | DNS | WINS

This checkbox only applies when you are connected to a local
network and a dial-up network simutanesoushy. When checked, data
that cannot be sent on the local networ is forwarded to the dial-up
networl.

[] Use default gateway on remote network

[7] Disable class based route addition

Automatic metric

Interface metric;

FPP link

[] Use IP header compression

| ok || cancsl

Advanced TCP/IP Settings

5. Both checkboxes "Use default gateway on remote network" and "Use IP header

compression" should be unchecked.

6. Click OK three times to exit the properties dialog.

33
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Station Setup
Station Setup

Sending and receiving stations must be set up properly before messages can be sent or
received.

For additional information on radio setup, refer to Radio Setup and the appropriate radio
operation manual. It is recommended to use the CPA for RF-7800H, CPA for RF-5800H, or
CPA for AN/PRC-150 for programming the radio with mission parameters.

For additional information on the Tactical Chat user interface, refer to User Interface.

The following topics are covered in this section:
e Connections:

e Ethernet Address:

e Set Self Address:

e My Station:
e Talking To:

o Delete Station
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Connections
The Connections selection supports the following options.

NOTE: The application will need to be restarted when switching
connection types.

e Dial-up Connection
e Harris Automatic IP Radio Connection (COM1)
e Harris Radio Connection

e Ethernet
Required Drivers

In order to connect to network capable radios, special drivers are required.

The Network Radio Driver Installer (NRDI) application offers a simple mechanism to the user of
network capable radios to install the modem driver necessary to establish a PPP connection
between the radio and the computer. The necessary driver is installed on a user-specified serial
port as described in the NRDI installation. Refer to the NRDI help for details on port speed and
features.

The Harris Remote Network Driver Interface Specification (RNDIS) Network Device driver
provides support for an Ethernet connection. This driver is installed as described in Connecting
Computer and HF Radio.

Dial-up Connection

The dial-up connection uses a serial port to make a PPP connection. The NRDI application
automatically creates this entry to support this connection.

Harris Automatic IP Radio Connection (COM1)

This is the default automatic IP entry name for the NRDI connection when COM1 is selected. It
uses a serial communications port (1, 2, or 3 for example) to make a PPP connection. The radio
and the Tactical Chat application default the Radio IP Address to 10.0.0.1. Check the radio at:
[PGM] > CONFIG > NETWORK > INTERFACE > PPP > ADDRESS > ENABLE PPP PORT
(YES).

Harris Radio Connection

This connection uses a serial port to make a PPP connection. NRDI is used to support this
connection.
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Ethernet Connection

RF-7800H-MP supports an Ethernet connection using a Direct USB cable, 12043-2850-A006.

Record the radio IP ADDRESS for entry into Tactical Chat by checking the following (default
Ethernet Address is: 169.254.078.001).

Check that the radio is configured for a DIRECT USB Ethernet interface ([PGM] >
CONFIG > NETWORK > INTERFACE > ETHERNET > ADDRESS > ETHERNET
PORT TYPE set to DIRECT USB and the Dynamic Host Configuration Protocol
(DHCP) SERVER is ENABLED.

These rules apply to the Ethernet Address.
e The fourth byte cannot be 0 or 255.
e The address must be either Class A, B or C.

e The first byte cannot be 127.
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Ethernet Address

The Radio Ethernet Address must be entered when Ethernet is selected as the connection
type. The general format for the address is: ##.#.#.#. The Ethernet Address must match the
address configured on the radio. The radio and the Tactical Chat application default the IP
Address to 169.2543.78.1.

NOTE: It is recommended that the user NOT modify the IP
Address. If the IP Address is modified, the Tactical Chat
application and the radio must be restarted for the IP Address
change to take effect.
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Set Self Address

The Set Self Address: field is used to enter the Self Address (radio address) of the local radio.
When the Self Address field is changed, the My Station field will update the next time the mouse
is clicked on an Tactical Chat field.

The radio address is a means of identifying a radio in a network. It consists of 1-15
alphanumeric (a-z, A-Z, 0-9) characters.

The self-address used is dependent on the operational mode of the radio as shown in the
following table:

Mode Self Address

ALE *** ARQ Self Address
FIX *** ARQ Self Address
HOP *** ARQ Self Address
3G *** 3G Address

*** |If the CPA or HF-RPA is used to program the radio, ARQ self address is the same as ALE
self address.
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My Station

My Station is the local station. The My Station: field should contain the Self Address of the
local station.

The My Station: field will automatically update to match the Set Self Address field whenever a
new Self Address is entered. After typing in the Self Address, click another field ( the
Conversation Pane is recommended), to cause the My Station: field to update to the current
Self Address.
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Talking To

Use the Talking To: field drop-down menu to enter or select the remote station's address with
whom you wish to communicate.

Broadcast messages can be sent from one station to multiple stations in the same subnet by
selecting all from the Talking To: drop-down list.

To add another station to the Talking To: list, just type the remote station address into the
Talking To: field, and then click in the Conversation Pane to update the field. The new station
will automatically be added to the drop-down list.
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Delete Station

Deletes the currently selected station from the Talking To: station list. All stations is a default
value that cannot be deleted.

41



10515-0294-5002

Operation
Operational Overview

A variety of Tactical Chat messaging features are available to provide control of display options,
message composition and sending, and statusing. In addition, radio station parameters must be
set properly before messages can be sent or received.

For a general overview of Tactical Chat application, refer to the Application Overview.

The following topics are covered in this section:

e Starting Tactical Chat

e User Interface

e Creating and Sending Messages

e Tactical Chat Options

e Shortcut Keys
e Statusing

42



Help and Support
Starting Tactical Chat

Click the Tactical Chat icon t a on the PC desktop to start the Tactical Chat application.

If Tactical Chat is minimized, the application can also be accessed by double-clicking the
Tactical Chat icon in the system tray or clicking the taskbar.

When Tactical Chat is running in the background, the Tactical Chat message window will open
automatically if a message is received.
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Tactical Chat User Interface

The Tactical Chat user interface can be displayed using either the Classic View or the Green
View. These two views are shown below, with the Classic View in sending mode, and the Green
View in receiving mode.

Tactical Chat Options are always visible when the Classic View is in use, but can be toggled on
and off using the Options button when the Green View is in use. Use Change View to toggle
between views.

CONVERSATION PANE OPTIONS

Tactical Chat |

by Station 106
7 W &uto Save
Save To Location:
\C:\Harris\Tactical Ch:

Savehs. |
Change Wiew
|Classic j

Connections

|Harris Automatic Ilj

Open | P | Print | Ahaut | Help | Ethernet Address
| 169 .254 . 78 . 1

Talking Te: {105 - DeleteStatiDnl
il | J Set Self Address

test test |1 06
¥ Show Time
v Chl-Enter For Send
\ [ Launch At Startup
Send | Send File | Maote _l ¥ Sound Alert
F Ready N \
\ kY
RADIO STATUS COMPOSITION PANE

Tactical Chat Classic View
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CONVERSATION PANE

OPTIONS

Tactical Chat - My Station:

15:54:57: [To:all From: 106] testtest ] AutI:::-SaVE
Save To Location:
Save As...
Change View: 5

Open... 34\ Print... Options... About = Help

Talking To: |

Set Self Address:
Send

[® Show Time

[®] Ctrl-Enter For Send
: O Launch At Startup
F Ready Send File... [ Sound Alert

S

RADIO STATUS COMPOSITION PANE

MNote

Tactical Chat Green View - Options Visible
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Creating and Sending Messages
Creating and Sending Messages

Tactical Chat messages can be created and sent within the application.

Radio Setup and Station Setup must be complete before messages can successfully be sent or
received.

The following topics are covered in this section:

e Composition Pane

e Conversation Pane

e Creating a Message

e Sending a Message

» Send

» Abort

» Note

e Send File
« Open

e Save

e Print

e Options Button

e About
e Help
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Composition Pane

The Composition Pane is the text window located in the lower portion of the Tactical Chat user
interface. The Composition Pane permits the user to type in a new message for transmittal.

Clicking anywhere inside the Composition Pane will activate a blinking text cursor in the upper
left corner of the Composition Pane. A message can then be typed in using standard ASCII
characters.

Notes can also be typed into the Composition Pane. Refer to Note for more information.
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Conversation Pane

The Conversation Pane is the text window located in the upper portion of the Tactical Chat user
interface. The Conversation Pane displays the contents of incoming and outgoing messages,
error messages, and notes.

Use the Auto Save function to automatically save the contents of the Conversation Pane to file.

The message time stamp is also displayed in the Conversation Pane, when enabled. For
information on the message time stamp, click here: Show Time.

Text can be copied from the Conversation Pane to the Windows clipboard.
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Creating a Message

Create a message by typing message text into the Composition Pane.

Messages can be typed into the Composition Pane directly, or pasted in from another
application.

Messages can only contain standard ASCII characters, and cannot be more than 64K in size,

not including attached file size. For information on attaching and sending files, click here: Send
File.
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Sending a Message

Click the Send button, ENTER, or CTRL+ENTER to send a message.

Before sending a message, the mode of operation and appropriate presets must be selected by
the user from the front panel of the radio. Tactical Chat does not provide automatic linking
functionality except in 3G mode. ALE links must be established from the front panel of the radio
prior to sending a message.
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Send

Click the Send button to send a message that has been typed or pasted into the Conversation
Pane.

Text messages can be up to 64 K in size, whether typed in or copied from another application.
For information on sending attached files with a message, click here: Send File.

When a message is in the process of being sent or received, the Send button is replaced with
the Abort button.
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Abort

The Abort button is used to abort a message that is in the process of being sent or received.
The Abort button is only visible while a message is in the process of being sent or received,
when it temporarily replaces the Send button.

Tactical Chat uses an immediate abort feature. Aborting a message that is currently being
transferred does not notify the remote station that an abort has occurred.
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Note

This feature allows a note to be typed into the Conversation Pane. Notes cannot be sent or
received.

To create a note, click Note and type the note into the Conversation Pane.
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Send File

The Send File function permits a file to be attached to and sent with an Tactical Chat message.

The maximum file size for an attached file is dependent on radio setup. In ARQ mode, the
maximum attached file size is 2 MB.

To send a file, perform the following procedure:

1. Create a message. For information on creating a message, click here: Creating and
Sending Messages.

2. Click the Send File button. This will send both the selected file and any text message
that is in the Composition Pane.

3. Use the Browse feature to navigate to the file you want to send.

4. Highlight the desired file, and click Open.
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Open...

Clicking the Open... button displays the Load From... dialog window. Use this window to select
a previously saved Tactical Chat message file and open it in the Conversation Pane.

Tactical Chat message files use the file extension .cht. Only Tactical Chat message files can be
opened within the Tactical Chat application.
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Save...

If Auto Save is disabled and a Save file location has not been established, clicking the Save
button opens the Save To... dialog box. This permits saving the contents of the Conversation
Pane to a specified file location.

If a Save file location has been established, clicking on the Save button will save the current
contents of the Conversation pane to the current Save file location.

To save the contents of the Conversation Pane to a chat message file:
1. Navigate to the desired file location.
2. Type a file name in the File name: field.
3. Click Save.

Tactical Chat messages must be saved with the file extension .cht, and can only be reopened
within the Tactical Chat application.
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Print

Opens the print dialog box. You need to have at least a single line of text in the conversation
pane before printing can start.
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Options Button

This button will open the Chat Options menu for the Green View display. The Tactical Chat
Options are displayed by default on the Classic View display.

The Options display on the Green View can be closed using the "X" button at the upper right
corner of the Options menu.
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About

Provides version and copyright information for the currently installed Tactical Chat software.
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Help

Opens the Tactical Chat Help application.
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Tactical Chat Options
Tactical Chat Options

Tactical Chat Options allow selection of various operational and display settings.

Options settings are always visible when the classic view is used. To view options settings when
the default (green) view is used, click on the Options button.

The following topics are covered in this section:
e Auto Save

e Save To Location

e Connections (Station Setup section)
e Save As

e Change View

o Classic View

e Green View

o Set Self Address (Station Setup section)

e Show Time

e Citrl-Enter For Send

e Launch At Startup

e Sound Alert
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Auto Save

Auto Save allows the contents of the conversation pane to be automatically saved to file as
messages are sent and received. All Tactical Chat files must use the .chx file extension.

1. Check the Auto-Save check box to enable the Auto Save option. When the box is not
selected, the Save selection becomes active.

2. Select Save As to open the Select a file to auto save to... dialog box.

3. Navigate to and select the folder you want to automatically store Tactical Chat message
files in.

4. Type in the desired file name and click the Save button. The selected file location will be
displayed in the Save To Location: field.

Auto Save Directory Selection:

The first time Tactical Chat is started, a default Auto Save directory is selected by the
application. On subsequent Tactical Chat startups, the default Auto Save directory will default to
the directory last selected by the user.
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Save To Location:

The Save To Location: field displays the current file destination for saved Tactical Chat
messages.
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Save As...

Clicking the Save As... button opens the Save File As dialog box. Use the Save File As dialog to
change the directory for storage of Tactical Chat files.
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Change View

The Change View drop-down menu is used to select the desired display scheme for the Tactical
Chat user interface.

The Classic View is the only available display scheme when using monitors that are set to 256
colors or less.

The Green View displays by default when using monitors that are set to higher than 16 colors.
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Classic View

The Classic View displays the Tactical Chat user interface in a standard Windows format and
color scheme.

The Classic View is the only available display scheme when using monitors that are set to less
than 256 colors.

Views can be toggled between the Classic View and Green View displays using the Change
View drop-down menu.
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Green View

The Green View displays by default when using monitors that are set to higher than 256 colors.

Views can be toggled between the Classic View and Green View displays using the Change
View drop-down menu.

67



10515-0294-5002

Show Time

When this checkbox is checked, the current time will automatically be inserted before the
Tactical Chat message in the Conversation Pane.
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Ctri-Enter For Send

When this checkbox is checked, the Ctrl-Enter key combination can be used to send a message
that has been typed into the Composition Pane. If this checkbox is not checked, the Enter key
can be used to send a message.
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Launch At Startup

When this checkbox is checked, the Tactical Chat application will launch automatically when the
PC is started up.
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Sound Alert

Provides an audible alert when a message is successfully transferred, or when a message fails
to transfer.
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Shortcut Keys

Shortcut Keys

Shortcut keys for the Tactical Chat application are as follows:

Shortcut for

Minimize window

Exit application

Go to Self Address Field:

Go to Composition Pane

Select all in Composition Pane

Go to Talking To: Destination Field
Go to Conversation Pane

Select Open

Select Save

Select Print... (Print Conversation
Pane)

Select About

Select Help

Select Delete Station
Select Send

Abort Message Transfer

Select Note (insert note into
conversation pane)

Select Send File

Display Options...
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Key combinations

Ctrl + M

Alt + F4

Ctrl + J

Ctrl + D

Ctrl + A

Ctrl + Shift + D

Ctrl + 1

Ctrl+ O

Ctrl+ S

Ctrl + P

Ctrl + H

F1

Ctrl + Shift + X

Ctrl + Enter

Ctrl+ Z

Ctrl + N

Ctrl+ F

Ctrl + U



Toggle Auto-Save check box
Select Save As...

Go to Connections selection field
Go to Ethernet Address field

Go to Change View box

Toggle Show Time check box

Toggle Ctrl-Enter For Send check
box

Toggle Launch at Startup check
box

Toggle Sound Alert check box

Ctrl +Y

Ctrl + B

Ctrl + Shift + P

Ctrl + Q

Ctrl + Shift + S

Ctrl+T

Ctrl + E

Ctrl + G

Ctrl + R

Help and Support
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Statusing
Statusing Features

The Tactical Chat application provides statusing information on the following:

o Radio Status
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Radio Status

The Tactical Chat application monitors the status of the locally attached radio as Tactical Chat
messages are sent.

Radio status is displayed in the Radio Status field. The radio status field is located below the
Composition Pane for the Classic View. The radio status field is located in the lower portion of
the Composition Pane for the Green View. Refer to User Interface to see examples of Radio
Status messages.

The following Radio Status messages may be displayed, dependent upon current system
status:

Radio Status Messages:

Radio Status Message Meaning

Starting up... Please wait. Tactical Chat application is
initializing communication
with the radio.

Ready Tactical Chat application is
ready to send or receive a
message.

Sending Tactical Chat application is

sending a message.

Receiving Tactical Chat application is
receiving a message.

No Radio Communications | The Tactical Chat application
and the radio have lost
communications. Messages
cannot be sent or received.
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Technical Support

Support Overview

We recognize that continued success in our business requires a strong commitment to
customer support both before and after the sale. We offer this support not only through our
sales and service facilities in nearly 90 countries around the world but also through our
Technical Customer Service Department. This department can assist our customers in the
specification, installation, operation, and maintenance of all of our products.

In addition, further help is available via direct communications with our main facility in

Rochester, New York using any method shown below:

Mail

Harris Corporation

RF Communications Division
1680 University Avenue
Rochester, NY 14610

USA

Telephone

Fax

E-mail

1-866-264-8040 (toll-free)
1-585-242-3561

1-585-242-4483

rfcsrvc@harris.com

Supported Operating Systems

The supported operating systems* are:

Windows XP Pro (32 bit)
Windows Vista (32/64 bit)
Windows 7 (32/64 bit)

Windows Server 2003 (32/64 bit)
Windows Server 2008 (32/64 bit)
Windows Server 2008 R2 (64 bit)

* All Operating Systems tested using latest service packs.
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What's New

RF-6551H HF Tactical Chat v2.0 includes the following new features:

Support for RF-7800H-MP and direct USB/Ethernet interface option for single client only
(this is an addition to existing PPP connections)

Improved RDP+ protocol support (larger buffers now 1469 bytes)
Usability improvements

New Operating Systems support

NRDI v1.7 provided (needed for Windows 7 support)

Compatible with prior version of Tactical Chat
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Compatibility
The listings below provide compatibility information.
Firmware Support
Tactical Chat will function correctly with all supported HF radio firmware versions.
File Exportability
Mission Plan files are exportable for use with:
e RF-6760W Wireless Message Terminal (WMT) version 1.4, 1.5.x
e RF-6760W-High Performance Waveform (HPW) version 1.4
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FAQs
FAQ Index

This section provides information on Frequently Asked Questions. Click on a link below to show
the answers and solutions to each FAQ.

Installation
e FAQ-1026: Harris RFC Radio Connection modem fails to be added during install.
e FAQ-1027: Install prompts for Dial-Up Networking.
General Information
e FAQ-1002: Messages larger than 2 MB cannot be transferred.
e FAQ-11: | cannot get the default view of the Tactical Chat user interface to display.
o FAQ-12: What does a custom install do?
Hardware Configuration Issues
e FAQ-1006: Message transfer fails from PT to CT.
Software Configuration Issues
o FAQ-1022: Why does Tactical Chat fail to initialize upon start-up?
Operational Issues

e FAQ-01: Chat status is Ready but when | send a message or a file, Chat displays '[Error:
Unknown]' in the Conversation pane?

o FAQ-02: | configured my radio in 3G mode, and Tactical Chat went to the Ready state.
However, when | sent a message, the receiving station did not receive it. And the same
thing happened when the other station sent a message to me. The message seemed to
have been received by Chat, but | did not see any new message in the Conversation
pane.

e FAQ-03: | got a message that says 'Message received is not intended for this station’
when my application finished receiving.

o« FAQ-04: | was expecting to receive a file called 'picture.gif' that the other station sent to
me as an attachment. However, when | received the file, the name was changed to
'picture.ERR'".

o« FAQ-05: | was expecting to receive a file called 'system.gif' that the other station sent to
me as an attachment. However, when | received the file, the name was changed to
'system1.gif'.

o FAQ-06: The Tactical Chat application stays in the "No Radio Communications" state
after | restarted the application. It was in the "Ready" state just before | closed the
application and launched it again.
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e FAQ-07: | pressed the 'Print..." button but the Print dialog box did not appear.

e FAQ-09: | sent a message and | got '[ Error: Link is Busy ]'. Shortly after that the
application went into receiving mode.

o FAQ-10: | sent a message and | got '[Error: Message Error Aborted]'.

e FAQ-13: Why is the Tactical Chat application in the No Radio Communications state
after | switch to the Ethernet connection and restart Tactical Chat?

o FAQ-14: Why can’t | send/receive messages or files with Tactical Chat using 2G ALE?
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FAQ-01

Question:

Chat status is Ready but when | send a message or a file, Chat displays '[Error: Unknown]' in
the Conversation pane?

Answer:

Causes

The radio is in ALE mode, but a link has not been established yet.

Resolution

Create a link before sending. To create a link in ALE mode, follow these steps:
1. Press the 'Call' button on the front panel of the radio.
2. Select 'Automatic’ and press the 'Ent' button on the radio.

3. Press the Up or Down arrow key to choose the station that you want to link to and then
press 'Ent'. The radio will then try to make a link to the selected station name.

Once the radio is linked, you can start typing sending messages or files. A radio link is indicated
by the link symbol in the display on the front panel of the radio.
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FAQ-02

Question:

I configured my radio in 3G mode, and Tactical Chat went to the Ready state. However, when |
send a message, the receiving station did not receive it. And the same thing happened when
the other station sent a message to me. The message seemed to have been received by Chat,
but | did not see any new message in the Conversation pane.

Answer:
Causes

Radio is configured for 3G mode, but the Self address is not set to the 3G mode address.

Resolution

Click the Options button and type in the 3G self address for your station in the Set Self
Address box.

82



Help and Support

FAQ-03

Question:

| got a message that says 'Message received is not intended for this station' when my
application finished receiving.

Answer:

Symptoms

Unable to see the received message. The error message "Message received is not intended for
this station" message is displayed instead.

Causes

The receiving address of the message received is not the address of the local station, 'ALL', or
'Unknown'.

Resolution

Make sure that you typed in the correct self address. If you are in 3G mode, make sure that you
have a 3G self address set as your self address in the Tactical Chat application. If you still
experience this problem and are sure that you have the right self address, the reason could be
that the message was not intended for you, but you just happened to receive the radio signal
because you are on the same frequency.

83



10515-0294-5002

FAQ-04

Question:

| was expecting to receive a file called 'picture.gif' that the other station sent to me as an
attachment. However, when | received the file, the name was changed to 'picture.ERR".

Answer:

Symptoms

The extension of the file sent was changed to ".ERR".

Causes

The application determined that file received may contain error(s).
Resolution

You may need to have the remote station send the file to you again, or you may attempt to open
the file and examine it yourself to see if the file contains errors.
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FAQ-05

Question:

| was expecting to receive a file called 'system.gif' that the other station sent to me as an
attachment. However, when | received the file, the name was changed to 'system1.gif".

Answer:

Symptoms

A number is appended to the name of the file.

Causes

A file with that name already exists in the Received Files directory.
Resolution

You could delete or move the files in the Received Files directory prior to receiving a file.
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FAQ-06

Question:

The Tactical Chat application stays in the "No Radio Communications" state after | restarted the
application. It was in the "Ready" state just before | closed the application and launched it again.

Answer:

Symptoms

The Tactical Chat application was in the Ready state, but when closed and restarted quickly, the
application stays in the "No Radio Communications" state.

Causes

The Tactical Chat application was launched again before Windows Dial up networking closed
down completely.

Resolution

Close the Tactical Chat application and wait until the Dial Up Networking icon in the System
Tray goes away (if an icon was visible), or wait about 10 seconds and then restart the
application.

More Information

If the Tactical Chat application is still in the "No Radio Communications" state, please refer to
the Tactical Chat Help to identify problems with the radio, the cable, or the software installation.
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FAQ-07

Question:

| pressed the 'Print..." button but the Print dialog box did not appear.
Answer:

Symptoms

No dialog box appears when the 'Print..." button is pressed.
Causes

There is no text in the Conversation pane to be printed.

Resolution

You need to have at least a single line of text in the conversation pane before printing can start.
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FAQ-09

Question:

| sent a message and | got '[ Error: Link is Busy ]'. Shortly after that the application went into
receiving mode.

Answer:

Symptoms

Receipt of an error message that says '[ Error: Link is Busy ]'. Shortly after the error message is
received, the application received a message.

Causes

Two stations were trying to send to each other at the same time. The station that received the
error message described above failed to send, but received the message that was sent to it.

Resolution

The station that received the error message needs to resend its message to the other station.
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FAQ-10

Question:

| sent a message and | got '[Error: Message Error Aborted]'.
Answer:

Causes

Incorrect or inconsistent modem or ARQ data routing settings on the sending and/or receiving
radio.

Resolution
Perform the following steps from the front panel of both the sending and receiving radio:
1. Press Program (PGM).
2. Select Config.
3. Select Message.
4

Make sure that 'Route Modem Data To' and 'Route ARQ Data To' are both set to
'RDP'.
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FAQ-11

Question:
| cannot get the default view of the Tactical Chat user interface to display.
Answer:

Symptoms

e The message "There aren't enough colors to display the requested view. The classic
view will attempt to be loaded." is displayed.

e Only the classic view will display.
Causes

More than 256 colors must be available to use the default view. If less than 256 colors are
available, only the classic view will display.

Resolution

Change the monitor color settings. Do Start > Settings >Control Panel and select Display.
Choose the Settings tab, and then use the Colors drop-down menu to select 16-bit color or
higher. The default view should now be able to be selected. If you do not have 16-bit or higher
color available, you will need to use the classic view.
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Question:
What does a custom install do?

Answer:

It is the same as a complete install. There are no optional components.

Help and Support
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FAQ-13

Question:

Why is the Tactical Chat application in the No Radio Communications state after | switch to the
Ethernet connection and restart Tactical Chat?

Answer:

Symptoms

The application stays in the No Radio Communications state after the Ethernet connection is
selected and | re-launch Tactical Chat.

Possible Causes:

e The RNDIS cable is not properly connected in your PC (station).
e The RNDIS driver is not properly installed.

e The Ethernet Address in Tactical Chat doesn’t match the IP Address in the RF-7800H-
MP Radio.

Resolution

1. Make sure that your Direct USB/Ethernet cable is properly connected. If possible, try a
different cable.

2. To verify if you have the driver for this cable installed, refer to the Ethernet Connection
for RF-7800H-MP and follow the steps described there.

3. On the RF-7800H-MP front panel (or KDU), go to PGM > CONFIG > NETWORK >
INTERFACES > ETHERNET, and verify that the IP Address in the radio matches the
Ethernet Address in the Tactical Chat application.
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FAQ-14

Question:
Why can’t | send/receive messages or files with Tactical Chat using 2G ALE?
Answer:

Symptoms

The application fails to send/receive data and the user gets the [Error: The transfer has stopped
unexpectedly. Please press F1 for Help] message.

Possible Causes:

e The Set Self Address in Tactical Chat does not match the ALE self address in the radio.
¢ You do not have an active link and you have to do a manual call with the radio.
Resolution
To create a link enabling the user to send/receive messages, do the following.

1. Make sure the Set Self Address in Tactical Chat matches the ALE self address. To verify
this address, on the radio front panel go to [PGM] > MODE > ALE > ADDRESS >
ADDRESS TYPE. With SELF selected, press [ENT]. In the ADD SELF ADDRESS view,
press the down arrow, select REVIEW and press [ENT]. This will give you the radio’s
ALE Self Address name. This is the address you need to add into the Set Self Address
textbox in Tactical Chat.

On the radio front panel (or KDU), press [CALL].
For the CALL TYPE, select MANUAL.
For the ADDRESS TYPE, select ALL.

o k&~ w b

Select the channel (CALL ON CH ###) and press [ENT].
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FAQ-1002

Question:

Messages larger than 2 MB cannot be transferred.
Answer:

Causes

This is by design. ARQ mode does not permit transfer of messages/files larger than 2 MB. In 3G
mode, messages/files larger than 2 MB can be transferred.

Resolution

We recommend breaking the file(s) down by using WinZip and sending these smaller chunks in
separate messages.

More Information

For help and information on breaking files down using WinZip, use the Help file in the WinZip
application. You can access this from the main menu in WinZip. WinZip can be obtained at
http://www.winzip.com.
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FAQ-1006

Question:

Message transfer fails from PT to CT.
Answer:

Causes

The sending HF station is set up with a radio in PT mode. The receiving HF station has a radio
set to CT mode. The message sent from the PT side to the CT side fails to get
delivered/received.

Resolution

Make sure both the sending and receiving HF stations are configured to be either both in PT or
both in CT mode at the time of transmission.

More Information

Messages sent from CT to PT will always fail since one radio is sending encrypted messages
and the other is receiving plain text messages. This is by design.
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FAQ-1022

Question:
Why does Tactical Chat fail to initialize upon start-up?
Answer:
Symptoms
Radio Status displays "No Radio Communications".
Causes
1. A cable is loose/not connected from the PC to the radio.
2. The radio is not turned on.
3. The cable that is being used is "bad".
Resolution
For case one: Make sure all cables are connected and secured to the equipment.
For case two: Make sure that the radio is powered on and has a consistent power supply.

For case three: Switch the cable that you are using to use a cable that is "known to be good".
Take a cable off a working station (that you have been able to pass messages with via the
Tactical Chat software) and try that one.

96



Help and Support

FAQ-1026

Question:

Harris RFC Radio Connection modem fails to be added during install.
Answer:

Causes

This problem occurs if the modem was previously installed and then removed.
Resolution

Reboot the machine and go into "Phone and Modem Options" under the Control Panel. Add a
new modem and click the checkbox that asks you to select your modem from a list. Then click
on "Have Disk" and select the mdmrfc.inf file on the root of the install CD.
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FAQ-1027

Question:

Install prompts for Dial-Up Networking.

Answer:

Causes

This problem occurs if Dial-Up Networking was not installed as part of the operating system.
Resolution

Install Tactical Chat. If Dial-Up Networking is not detected on the system a prompt will ask for
installation. Replace the Tactical Chat CD with the operating system CD (NT 4.0). Run the Dial-
Up Neworking installation from the operating system CD. Once complete reboot. Return the
Tactical Chat CD and continue with installation.
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Glossary
-A-
ADF Audio/Data/Fill (radio connector)
-B-
bps Bits Per Second
-C-
CD Compact Disk
CT Cipher Text
-D-
dB Decibel
-E-
ECCM Electronic Counter-Counter Measures, anti-jam modes of
either SINCGARS or HaveQuick frequency hopping.
ENT Enter
-F-
FM Frequency Modulation. Varying the frequency of the RF
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GPS

Hz

ITAR

LAN

100

carrier in proportion to the modulating signal.

-G-

Global Positioning System. A system using satellites to
provide position location and Time-of-Day used with
SINCGARS, HaveQuick, HPW, and ANW2/ANW2C.

-H-

Hertz

International Traffic In Arms Regulations

-J-

Kilo

Local Area Network



N/A

PC

RX

Squelch

Help and Support

meter(s)

Not Applicable

-O-

Personal Computer

Q-

Receive

The ability to mute the receive audio until the radio receives
the appropriate signal. Can be either digital squelch, tone
squelch, or noise squelch.
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-T-
X Transmit
-U-
us United States
V-
VAA Vehicular Amplifier Adapter, option for Falcon Il radios
-W-
w Watt
-X-
Y-
Z-
ZULU Time zone indicator for Universal Time used throughout the

world (also known as Greenwich Mean Time (GMT).
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